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Evaluates: MAX20353

General Description

The MAX20353 evaluation system (EV system) is a fully
assembled and tested circuit board that demonstrates the
MAX20353 ultra-low-power wearable power-management
integrated circuit (PMIC). The MAX20353 includes voltage
regulators such as bucks, boost, buck-boost and linear
regulators, and a complete battery management solution
with battery seal, charger, power path and fuel gauge.

The MAX20353 EV system comes with the MAX20353
board, the MAXPICO2PMB# board, and two micro-B
cables. The EV system comes with the MAX20353AEWN+
installed. The MAX20353 is configurable through an 12C
interface that allows for programming various functions
and reading the device status. The EV system GUI appli-
cation sends commands to the MAXPICO2PMB# adapter
board to configure the device.

Features
e USB Power Option

e Flexible Configuration

e On-Board LED Current Sink and Battery Simulation
e Sense Test Point for Output-Voltage Measurement
e Filter Test Point for Haptic Waveform Measurement
e Windows® 8/10-Compatible GUI Software

e Fully Assembled and Tested

Ordering Information appears at end of data sheet.

Windows is a registered trademark of Microsoft Corporation.

MAX20353 Evaluation System

EV System Contents

o MAX20353 EV system

o MAXPICO2PMB# board

e Two USB A-to-USB micro-B cables

EV System Contents

FILE DESCRIPTION

MAX20353EVKitSetupVxxx.exe PC GUI Program

MAX20353 EV System Board Pic
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MAX20353 Evaluation System

Quick Start
Required Equipment

Note: In the following sections, text in bold refers to items

directly from the EV system software installation.

MAX20353 EV system
Windows PC with USB ports

One USB A-to-USB Micro-B Cable and MAXPI-
CO2PMB# adapter board

One USB A-to-USB Micro-B Cable or Power Supply
(for battery simulation or battery voltage)

(Optional) One USB A-to-USB Micro-B Cable or
Power Supply (for charger input CHGIN)

One voltmeter

Procedure

The EV system is fully assembled and tested. Follow the

steps below to verify board operation:

1)

Visit https://www.maximintegrated.com to down-
load the latest version of the EV system software,
MAX20353EVKitSetupVxxx.zip located on the
MAX20353 EV system web page. Download the EV
system software to a temporary folder and unzip the
zip file.

Install the EV system software on your computer by
running the MAX20353EVKitSetupVxxx.exe program
inside the temporary folder.

Verify that all jumpers are in their default positions,
as shown in Table 1.

www.analog.com
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Connect the type-A end of a cable to the PC and
micro-USB end of a cable to the MAXPICO2PMB#
board, and connect the MAXPICO2PMB# to J13
located on the lower left of the EV system board.

Connect a USB A-to-micro-B cable from the com-
puter to J21 on the upper-right corner of the EV
system board to use USB VBUS to power the battery
simulation circuits on the board, or to power the bat-
tery simulation circuits from the VHC test point. (The
user can also use a Li-ion battery or power source to
evaluate the device if not using the battery simula-
tion circuits. Connect the battery or power source to
J2 on the EV system board. Skip step 6 if not using
the battery simulation.)

Use a voltmeter to check that VHC is about 5V and
the BATSIM test point is about 3.7V. To adjust the
BATSIM voltage, turn the R48 BATSIM potentiom-
eter. Place a shunt on J15, then confirm that TP BAT
is equal to the BATSIM voltage.

On the computer, open the MAX20353 GUI. It should
look like Figure 1; the status bar on the bottom dis-
plays MAX20353 Not Found.

Press the PB1 (KIN) button until the device enters
ON mode. The GUI then shows Connected and the
registers are read and displayed (Figure 2).

The EV system is now ready for additional evaluation.

10) To evaluate the battery charger, the user can shunt

J10 and plug in a USB micro-B cable to J1 of the EV
system to use the USB VBUS power, or externally
supply the charging power on TP CHGIN.
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MAX20353 Evaluation System
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(Z) Wearable Power Management MAX20353 EV Kit — >
File Device Options Help
General || Boost |i Buck 1 |i Buck 2 || LDOs “ Buck-Boost |i Other DC-DC || Haptic || Charg_tii! Register Map || Status |_
Chip Information (Read Only) Power Reset Commands
Hardware |D 01 Soft Reset Hard Reset Power Off
Firmware ID 01 Send Send Send
Power Configuration Mode 1111 L & &
Global Passive Discharge Enabled Delay
Boot Delay 120ms
LED Configuration MON Mux and GPIO Configuration
LED Current Step v MON Mux Enable MPC PFN
v
LEDO Enable Configuration  LEDO Current ? 7 ;
= = MON Off Mode Condition 2
LED1 Enable Configuration  LED1 Current Ei“ge" Fow 3
Z 4
LED2 Enable Configuration  LED2 Current MON Mux Pin Source :
- x MON Resistive Partition Ratio 0
| MAX20353 Mot Found

Figure 1. MAX20353 Not Found Status

www.analog.com
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MAX20353 Evaluation System
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(Z) Wearable Power Management MAX20353 EV Kit e >
File Device Options Help
General ., Eluos_t .:- Buck 1 _:. Buck 2 -_ LDOs | E!uu::k—EIcnnst_ .:- C}ihgrDC-DC [ Hapt.ic .. Charger_. Regist?r Map -Q_Status
Chip Information (Read Only) Fower Reset Commands
Hardware ID 3 Soft Reset Hard Reset Power Off
Firmware ID 2 e — —
Power Configuration Mode 0110 i = =
Global Passive Discharge Enabled Delay
Boot Delay 120ms
LED Configuration MOM Mux and GPIC Configuration
LED Current Step 0.6mA |~ MON Mux Enable MPC PFN
v
LEDO Enable Configuration  LEDD Current ? 7 ]
Off = 1X Step | = MON Off Mode Condition 2
LED1 Enable Configuration  LEDA1 Current ° Ei”;'fd Low 3
Off . 1X Step |+ 4
LED2 Enable Configuration  LED2 Current MON Mux Pin Source BAT y
Off v 1XStep - MON Resistive Partition Ratio 11 v
Connected

Figure 2. MAX20353 Connected Status

Detailed Description of Software

Software Startup

Upon starting the program, the EV system software auto-
matically searches for the USB interface circuit and then
for the IC device addresses. The EV system enters nor-
mal operating mode when the connection is established
and addresses are found. If the USB connection is not
detected, the status bar displays Munich 2 Not Found.
If the USB connection is detected, but the MAX20353 is
not found, the status bar shows MAX20353 Not Found.

ToolStrip Menu Bar

The ToolStrip menu bar (Figure 3) is located at the top of
the GUI window. This bar is comprised of File, Device,
Options, and Help menus whose functions are detailed
in the following sections.

File Menu

The File menu contains the option to exit out of the GUI
program.

www.analog.com

Device Menu

The Device menu provides the ability to connect or dis-
connect the EV system to the GUI. The Advanced — Use
USB2PMB2# option should be checked if using with the
USB2PMB2# adapter board.

Options Menu

The Options menu provides several settings to access
more features offered by the GUI. The Disable Polling
option lets the user read the registers manually instead
of getting automatically frequent register updates from
the IC. The Disable Fuel Gauge option allows the user
to set the fuel gauge to sleep mode through the 12C and
the quiescent current decreases when setting the fuel
gauge to sleep mode. The Disable Automatic Haptic
Configuration option allows the user to disable automatic
setting from the GUI. Otherwise, the GUI automatically
sets some recommended default configurations to the
haptic driver configuration registers as in Table 199 in the
MAX20353 data sheet.

Analog Devices | 4



MAX20353 Evaluation System

Help Menu
The Help menu contains the About option, which dis-
plays the GUI splash screen indicative of the GUI version
being used.

Tab Controls

The MAX20353 EV system software GUI provides a
convenient way to test the features of the MAX20353.
Each tab contains controls relevant to various blocks of
the device. Changing these interactive controls triggers
a write operation to the MAX20353 to update the register

Evaluates: MAX20353

contents. The Read All Registers button reads all the
configuration registers that are visible on the current tab
page. All statuses are polled continuously. The polling fea-
ture can be disabled in the Options section of the menu
bar by selecting Disable Polling.

General Tab

The General tab (Figure 4) provides information on
device info, set power reset command, enable LEDs, and
LED current sink setting, MON setting, PFNs, and MPCs
status and configuration.

(@) Wearable Power Management MAX20353 EV Kit

File Device Options Help

Figure 3. The ToolStrip Menu Items

() Wearable Power Management MAX20353 EV Kit

LEDO Current
1X Step  ~

LEDO Enable Configuration
Off v

LED1 Current
1X Step  ~

LED1 Enable Configuration
Off v

LED2 Current
1X Step  ~

LED2 Enable Configuration
Off *

— *
File  Device Options Help
General ._ Eluogt .:I Buck 1 _:. Buck 2 ._ LDOs | E!uck—Elunst_ .:I OthgrDC—DC [ Hapt.ic .' Charger_' F'.egist_ngap .Q_Status
Chip Information (Read Only) Power Reset Commands
Hardware ID 3 Soft Reset Hard Reset Power Off
Firmware D 2 = = =
Power Configuration Mode 0110 &l = =
Global Passive Discharge Enabled Delay
Boot Delay 120ms
LED Configuration MON Mux and GPIO Configuration
LED Current Step 0.6mA  ~ MON Mux Enable MPC PFN
0 & 1
o 1 d
MON Off Mode Condition 2
o Pulled Low ]
Hi-Z 4
MON Mux Pin Source BAT v
MON Resistive Partition Ratio 11 v
Connected

Figure 4. General Tab

www.analog.com
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Boost Tab
In the Boost tab (Figure 5), the user can enable boost, set boost voltage, and inductor current settings.

() Wearable Power Management MAX20353 EV Kit = x
File  Device Options Help
General || Boost || Buck 1 || Buck 2 || LDOs || Buck-Boost || Other DC-DC || Haptic || Charger || Register Map ||0 Status |
Boost Enable
Enabled
Enabled by MPC v
¢ Disabled Read All Registers
Cutput Voltage Inductor Peak Current
20V 425mA
Set Set
Passive Discharge Configuration @ ) Adaptive Inductor Peak Current
@) Fast Start
FET Scaling
Controlled by Enable after 100% of boot.

Connected

Figure 5. Boost Tab
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MAX20353 Evaluation System

Buck1/2 Tab

Evaluates: MAX20353

In the Buck1 and Buck2 tabs (Figures 6 and 7), the user can enable bucks, set buck voltages, inductor current settings,

DVS mode and voltage setting, and some additional settings.

(£ Wearable Power Management MAX20353 EV Kit

File  Device Options Help

x

General || Boost || Buclﬂ” Buck 2 || LDOs || Buck-Boost || Other DC-DC || Haptic || Charger || Register Map ||0 Status |

Buck 1 Enable

® Enabled
Enabled by MPC v
Disabled

Qutput Voltage
1.8V

Set

Active Discharge Configuration
Passive Discharge Configuration

DVS Voltage -

Alt DVS Voltage v -
Controlled by Enable after 100% of boot.

Read All Registers

Inductor Peak Current

Set

@ ) Adaptive Inductor Peak Current
Fast Start
FET Scaling

EMI Mode

Low EMI
# High Efficiency

Connected

Figure 6. Buck1 Tab

www.analog.com

Analog Devices | 7
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MAX20353

() Wearable Power Management MAX20353 EV Kit

File  Device Options Help

x

General || Boost || Buck 1 || Buck 2 || LDOs || Buck-Boost || OtherDC-DC || Haptic || Charger || Register Map ||0 Status |

Buck 2 Enable

Enabled
Enabled by MPC A
o Disabled

Output Voltage
0.9v

Set

| Active Discharge Configuration
(1 Passive Discharge Configuration

DVS Voltage

Alt DVS Voltage v
Controlled by Enable after 100% of boot.

Read All Registers

Inductor Peak Current

Set

@ ) Adaptive Inductor Peak Current
()" Fast Start

()" FET Scaling

EMI Mode

Low EMI
# High Efficiency

Connected

Figure 7. Buck2 Tab

www.analog.com
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MAX20353 Evaluation System Evaluates: MAX20353

LDOs Tab
The LDOs tab (Figure 8) lets the user enable LDOs, set LDO voltages, and change to load switch mode.
() Wearable Power Management MAK20353 EV Kit = et
File  Device Options Help
General || Boost || Buck 1 || Buck 2 || LDOs || Buck-Boost || Other DC-DC || Haptic || Charger || Register Map ||Q. Status |
LDO 1 Enable LDO 2 Enable
Enabled Enabled
Enabled by MPC b Enabled by MPC g :
¢ Disabled # Disabled Read All Registers
Clutput Voltage Qutput Voltage
1.2V 32V
Set Set
Active Discharge Configuration _ Active Discharge Configuration
Passive Discharge Configuration ' Passive Discharge Configuration
Load Switch Mode ' Load Switch Mode
Controlled by Enable after 100% of boot. Controlled by Enable after 100% of boot.
SafeQut LDO Located in Gther DC/DC Tab
| | Connected

Figure 8. LDOs Tab
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MAX20353 Evaluation System Evaluates: MAX20353

Buck Boost Tab
In the Buck Boost tab (Figure 9), the user can enable buck boost, set buck boost voltage, and inductor current settings.

(f) Wearable Power Management MAX20353 EV Kit — >

File  Device Options Help

General || Boost || Buck 1 || Buck 2 || LDOs || Buck-Boost || Other DC-DC || Haptic || Charger || Register Map ||D Status |

Buck-Boost Enable
Enabled
Enabled by MPC v
e Disabled Read All Registers
Cutput Voltage Inductor Peak Current
100mA
Set Set
Active Discharge Configuration ) Current Limited Qutput Mode
@ ) Passive Discharge Configuration
s, _ g g Clock Divider Setting (0-127) [0 | | Set
@ ) Ripple Reduction
EMI Mode Inductance Select
& LowEMI e 47pH
Controlled by Enable after 100% of boot. TR e ik
Connected

Figure 9. Buck Boost Tab
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Other DC-DC Tab
The Other DC-DC tab (Figure 10) includes the Charge Pump and SFOUT settings.

(£ Wearable Power Management MAX20353 EV Kit — >

File Device Options Help

General | Boost | Buck1 | Buck2 | LDOs | Buck-Boost | other Dc-DC | Haptic | Charger | RegisterMap | @ Status |

Charge Pump Enable SFOUT Enable
Enabled # Enabled
Enabled by MPC d Enabled by MPC i :
e Disabled Disabled Read All Registers
Cutput Voltage Cutput Voltage
av Y
e 6.6V e 33V
Set Set

Passive Discharge Configuration

Controlled by Enable after 100% of boot.

Connected

Figure 10. Other DC-DC Tab
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MAX20353 Evaluation System

Haptic Tab

Evaluates: MAX20353

The Haptic tab (Figure 11) lets the user choose the actuator type, haptic driver mode, and different settings for each

mode.

() Wearable Power Management MAX20353 EV Kit

File Device Options Help

Haptic Pattern Mode

RAM Haptic Pattern - MPC v

Real-Time [2C

External Tnggered - MPC v
e Disabled

RAM Haptic Pattern Mode

RAM Address 000 *
Last Sample Mot Last Sample v
Amplitude -25.20% of VFS v
Duration 25ms \
Wait 7oms v
Repeat Repeat 5 Times g
Start Address 0x00 ~ Write Pattern

General | Boost | Buck1 | Buck2 ' LDOs | Buck-Boost | Other DC-DC | Haptic :. Charger |

— x
_RegisterM-ap ..0 Status |
Haptic Mode Select VFS ooy
o ERM Mode
LRA Mode
Read All Registers
Advanced...
Real-Time [2C
Amplitude -0.00% of VFS v
External Triggered Mode
Amplitude Duration
Overdrive  -100.00% of VFS  » 20ms
Active -59.84% of VFS |~ 500ms  ~
Braking +100.00% of VFS  « 20ms  ~
Connected

Figure 11. Haptic Tab

www.analog.com
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MAX20353 Evaluation System

Charger Tab

The Charger tab (Figure 12) lets the user set charger
and thermistor monitor configurations. The charger and
thermistor status section constantly polls the charger and

Evaluates: MAX20353

thermistor status and displays any changes. The polling
happens even when the Charger tab is not selected. The
polling can be disabled by selecting Disable Polling in
the Options menu at the top of the application.

(@) Wearable Power Management MAX20253 EV Kit

File Device Options Help

Charger

Enabled
& Disabled

Thermal Regulation

Zone Charger BatReqg FChg
Enabled

Cold -150mV | »| 0.2xIFChg =

Cool -150mV | » | |0.2xIFChg ~

Room (X BatReg | +| [1.0xIFChg =«

VWarm -150mV  + | 0.2xIFChg ~

Hot -150mV  + 0.2xIFChg

| General | Boost | Buck1 | Buck2 LDOs Buck-Boost |

- X

DiherDC—DC' Haptiu:l Charger | Register Map @ Status
Thermal Monitor

Enabled

o Disabled
Read All Registers

Charger Status Thermistor Status

Charger off Detection disabled,

CHGIM not present.

Thermal Limits

Cold Limit 1.398V v
Cool Limit 1.398V -
Warm Limit 0.529v v
Hot Limit 0.529v v
Connected

Figure 12. Charger Tab

www.analog.com
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MAX20353 Evaluation System

Register Map Tab

The Register Map tab allows for the configuration of all
I2C registers and AP Commands, including those not
configurable in other tabs. In the top right corner of the
tab page, the user can select between direct 12C registers
and AP commands.

For direct 12C (Figure 13), the register to be read from or
written to can be selected in the left table. The right table
contains descriptions for each register field of the select-

Evaluates: MAX20353

ed 8-bit register. All bits, along with their field names, are
displayed at the bottom of the page.

To set a bit, click the bit label. Bold text represents logic
1 and regular text represents logic 0. To configure the
changes to the device, click the Write button at the bot-
tom right.

The user can click Read All to perform a burst read of all
registers.

@ Wearable Power Management MAX20353 EV Kit = O >
File  Device Options Help
|| General || Boost || Buck 1 || Buck 2 || LDOs || Buck-Boost || Other DC-DC || Haptic || Charger || Register Map ||@ Status
Read All Direct 12C -
| Addr Reqister Value ™ Field Mame Description
0x00 HW ID 0x03 Indicates the
Bit [7:0] HW ID current hardware
001 FWID 0x02 R
0x03 INTO 0x00
Ox04 IMNTA 0x00
0x05 INT2 0x80
0x06 Status0 0x38
0x07 Statusi 0x20
0x08 Statusz2 0x00
0x09 Status3 0x00
x0B SystemError 0x00
Menc ot askn lovnn ¥
7 6 5 4 3 2 1 0
HW ID[7] HwW ID[&] Hw 1D[5] HW ID[4] HW ID[3] HwW 1D[2] HW ID[1] HW ID[D]
Mote: Click text to set ar clear bit and "Write™ to commit to device. Bold text is logic 1. Regular text is logic 0. Read ‘Write
| | Connected  .:f

Figure 13. Register Map Tab Direct I12C

www.analog.com
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MAX20353 Evaluation System Evaluates: MAX20353

For AP commands (Figure 14), the left table is populated command by clicking the Send Opcode button at the bot-
with all AP commands in the order of their operation tom right of the tab page.

codes. When an AP command is selected, its APDataOut/ A common action when sending AP commands manu-
In registers expand under it. Selecting an APData register ally is to send a read opcode, modify one specific setting
shows the individual bit descriptions and allows the user (like VSet or BstEn), then send the corresponding write

to read/write individual bits just like the direct 12C option. opcode. To speed up this read/modify/write action, the
After writing or before reading the APData registers, the APDataln to APDataOut button in the top left of the tab
user can send the operation code for the selected AP page can copy all APDataln registers to the APDataOut
registers.
() Wearable Power Management MAX20353 EV Kit . O >
File  Device Options Help
General || Boost || Buck 1 || Buck 2 || LDOs || Buck-Boost || Other DC-DC || Haptic || Charger || Register Map |[@ Status
APDataln to APDataCut AF Commands -
Opcode Command Lty Field Mame Description ™|
Ox01 | GPIO_Config_Write Contains:
APDataOut0 gﬁ:ggg;nd,
APDataOutt APDataOut0 [4:0] APDataOutd GPIO0HiZB,
APDataOut2 gﬁ:gg;‘fs-
ARPDataOut3 Contains:
APDataOutd GPIO1Cmd,
GPRIO104d,
0x02 GPIO_Config_Read APDataOut1 [4:0] APDataOut1 CPIO1HIZE
0x03 GPIO_Control_Write GPIO1Res,
GPIO1Pup.
0x04 | GPIO_Control_Read Cﬂmamg_‘}
0x06 MPC_Config_Write GF'IDECrﬁd,
N7 MPr Canfin Baad Dl e R GPRI0Z20d, 2]
7 6 5 4 3 2 1 0
Mote: Click text to set or clear bit and "Write™ to commit to device. Bold text is logic 1. Regular text is logic 0. Write Send Opcode
| | Connected

Figure 14. Register Map Tab AP Commands

www.analog.com Analog Devices | 15



MAX20353 Evaluation System

Status Tab

The Status tab (Figure 15) shows the user the state of the
interrupt registers, INTO—INT2, and the status registers,
Status0-Status3. The Read Interrupts button reads all

Evaluates: MAX20353

INT and STATUS registers and updates the text color to
teal to indicate a 1 was read. Interrupt polling can be dis-
abled by selecting Disable Polling in the Options menu
at the top of the application.

File  Device

Int0

ThmStatint
ChgStatint
ILimint
UsbOVPInt
UsbOkint
ChgThmSDint
ThmRegint
ChgTmolnt

Status0

ThmsStat[2]
ThmsStat[1]
ThmStat[0]
ChgStat[2]
ChgStat[1]
ChgStat[0]

Opticns

General | Boost | Buck1 | Buck2 | LDOs

(£) Wearable Power Management MAX20353 EV Kit

Buck-Boaost
Int1

ThmSDint
BstFltint
ThmBuck2Int
ThmBuck1Int
UVLOLDOZInt
UVLOLDO1Int
ThmLDOZInt
ThmLDO1Int

Status1

ILim

UsbQVP
UsbOk
ChgJEITASD
ChgJEITAReq
ChgTmao

Other DC-DC Haptic

Int2

APCmdRespint
SysErrint

LRALocklnt
LRAActInt
BBstThmint
SysBatLimint
ChgSysLimint

Status2

ThmsD
BstFlt
ThmBuck?
ThmBuck1
UVLOLDO?2
UVLOLDO
ThmLDO?2
ThmLDO1

| Charger | Register Map Q Status

. x

Q Interrupt Detected
Read Interrupts

Mate: Interrupts clear on
read. Interrupts can be
masked by modifying
the IntMask registers
(0x0C-0x0E).

Status3

APCmdResp
Syskrr

LRALock
LRAAct
BBstThm
SysBatLim
ChgSysLim

Connected

Figure 15. Status Tab

www.analog.com
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MAX20353 Evaluation System

Detailed Description of Hardware

The MAX20353 EV system evaluates the MAX20353
ultra-low-power wearable PMIC, which communicates
over the 12C interface. The EV system demonstrates
the IC features such as boost, bucks, linear regulators,
buck-boost, LED current sink, battery charger, and haptic

Evaluates: MAX20353

driver. The EV system uses the IC in a 56-bump wafer-
level package on a proven, four-layer PCB design. The
EV system can use USB VBUS +5V DC for battery and
charger input-power source. Alternatively, the EV system
can be powered from an external power supply. Figure 16
shows the EV system block annotated pictures (see the
MAX20353 EV System Board Pic).

AINT A R,'S.T, ‘
LEBSED

WAPTIC A ca ¢
OUTPUT

v

(o)

Figure 16. MAX20353 EVSYSKIT Block Annotated Picture

www.analog.com
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MAX20353 Evaluation System

Hardware Setup

To use the EV system with the GUI, connect the
MAXPICO2PMB2# to the PMOD connector in the bot-
tom left corner of the board. The MAXPICO2PMB2# also
provides 3.3V to the logic voltage VIO of the EV system
when shunting J20. The user can use J21 USB VBUS to
power the battery simulation circuits on the EV system to
supply BAT of the IC. Turning the R48 potentiometer can
change the BATSIM voltage. Connect BATSIM to BAT of
the IC with a shunt on J15. Alternatively, instead of using
battery simulation circuits on the board, the user can con-
nect their Li-ion battery on the J2 connector. The user can
use the J1 USB VBUS as the CHGIN source and place a
shunt on J10.

PFNs and MPCs States

The PFNs and MPCs can be pulled up to VIO through a
100kQ resistor, or connected to ground through a 100kQ
resistor.

Regulators and Peripherals

All regulator outputs are made available on test points.
The inputs to the LDO1, and LDO2 must be supplied
externally through test points. Bucks, buck-boost, boost,
and charge pump outputs have sense test points which
provide easy voltage measuring.

Thermistor and SET Adjustment

When the J4 shunt is installed, THM is pulled up to TPU
through a 10kQ resistor. Header J5 is used to select the
pull-down resistor for THM. When pin 1 and 2 is shunted,
potentiometer R31 is used to simulate a thermistor at
THM. When pin 2 and 3 is shunted, a fixed 10kQ resistor
is connected between THM and ground.

Header J19 is used to select the resistor for RjggT, which
sets the fast charge current (Ircyg). Shunting pin 1 and
2 selects potentiometer R33 and the user can change
RisgT to change IFcHg. Shunting pin 2 and 3 selects a
fixed 39kQ resistor, which sets the fast charge current to
51mA.

INT and RST LED Indicators

Shunts can be installed on J11 and J12 to show the status
of INT and RST as LED indicators, DS2 and DS3. When
the corresponding LED luminates, it means the active-low
output is pulled low.

www.analog.com
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Haptic Driver

The haptic driver output is on J3 where an LRA or ERM
vibration motor can be connected. By shunting J24 and
J25, the user can measure the haptic waveform with the
on-board low-pass filters, which convert PWM to a sine
wave.

LED Current Sink

The EV system includes multiple LEDs to test the LEDO,
LED1, and LED2 current sinks. The current source for
LED1 and LED2 can be connected to SYS by shunt-
ing J14. The current source for LEDO can be selected
between SYS and BSTOUT by J23. Using J24, the user
can select between sinking the current from one LED or
three LEDs for LEDO.

Jumper Setting

Table 1 shows the detailed jumper setting, and Table 2
shows the connector description.

Fuel Gauge Software

The MAX20353 integrates the MAX17048, a fuel gauge
IC which implements the Maxim ModelGauge ™ algorithm.
Use the MAX20353 Fuel Gauge GUIl and MAXPICO2PMB
to evaluate the ModelGauge™ fuel gauge.

Software Installation

Visit https://www.maximintegrated.com to download
the latest version of the Fuel Gauge EV kit software,
MAX20353FuelGaugeSetupVxxx.zip located on the
MAX20353 EV Kit web page. Download the software to
a temporary folder and unzip the zip file. Install the Fuel
Gauge EV kit software on your computer by running the
MAX20353FuelGaugeSetupVxxx.exe program inside the
temporary folder.

Hardware Setup
The following procedure applies to the MAX20353 EVKIT:

1) Connect the MAXPICO2PMB Adapter Board to J13
of the MAX20353 EVKIT.

2) Connect jumper J10 and remove jumper J15.

3) Connect the application’s battery to jumper J2 and
ensure the battery’s polarity connection.

4) Connect the MAXPICO2PMB Adapter Board to the
computer USB port via USB A to USB Micro-B cable.
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MAX20353 Evaluation System Evaluates

Table 1. Jumper Setting

: MAX20353

JUMPER SHUNT POSITION DESCRIPTION
J4 1-2* Connect THM to TPU for thermistor monitoring
5 1-2 Connect THM to a potentiometer

2-3* Connect THM to 10kQ (50%/room zone)
1-2 Pull down MPC3 to ground
J6 1-3 Connect MPC3 connect to GPIO4
1-4 Pull up MPC3 to VIO
1-2 Pull down MPC2 to ground
J7 1-3 Connect MPC2 to GPIO3
1-4 Pull up MPC2 to VIO
1-2 Pull down MPC1 to ground
J8 1-3 Connect MPC1 to GPI02
1-4 Pull up MPC1 to VIO
1-2 Pull down MPCO to ground
J9 1-3 Connect MPCO to GPIO1
1-4 Pull up MPCO to VIO
J10 1-2 Connect CHGIN to USB VBUS from J1
J11 1-2* Connect INT to pull up VIO and DS2
J12 1-2* Connect RST to pull up VIO and DS3
J14 1-2 Supply LED1/LED2 from SYS voltage
J15 1-2 Connect BATSIM to BAT
16 1-2 Pull up MPC4 to VIO
2-3 Pull down MPC4 to ground
17 1-2 Pull up PFN2 to VIO
2-3 Pull down PFN2 to ground
18 1-2 Pull up PFN1 to VIO
2-3 Pull down PFN1 to ground
119 1-2 Connect SET to potentiometer
2-3* Connect SET to 39kQ (fast charge current 0.05A)
J20 1-2* Connect VIO to 3.3V from PMOD
J22 1-2* Connect VHC to USB VBUS from J21
123 1-2 Supply LEDO from SYS
2-3 Supply LEDO from BSTOUT
Jo4 12 Conne_ct DRP to a low-pass filter, which converts PWM to a sine wave. The measures
are a filtered waveform at DRP_F.
25 12 Conne.ct DRN to a low-pass filter, which converts PWM to a sine wave. The measures
are a filtered waveform at DRN_F.
126 1-2 Connect LEDO to one LED
2-3 Connect LEDO to three LEDs
139 1-2 Connect SDA to ground
2-3 Connect SCL to ground

*Default position.
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Table 2. Connectors Description

Communication Port

CONNECTOR

DESCRIPTION

The Fuel Gauge software automatically finds the

J1

Connect to the USB cable for CHGIN voltage

MAXPICO2PMB adapter when connected to any USB

port. Communication status is shown on the left-hand side

J2 Connect to Battery of the bottom status bar. See Figure 17. If communication
J3 Connect to the LRA/ERM haptic actuator is valid, a green bar updates as the software continuously
J13 Connect to MAXPICO2PMB2# reads the IC registers.
121 Connect to the USB cable for battery Main Window
simulation Most major functionality is available from the main
window. (see Figure 18).
r— Reading.. [¥ Periodically Read Regsters

Figure 17. Bottom Status Bar

@ MAXT 7048/ MAKTT04S Evaluation Kit 2.2

maxim
integrated-.

| Load Custorn Model I Verify ||

VCell
L)

K 3.705 Wicell

Start Data Log | Stop Log | |

20 = “C->RCOMP

Registers  |°C Communication Log  Chart

Write RCOMP

Documentation

Register Name Command Valuge  Meaning
axe2 @xB948 | 3.705 V/cell

Description L
Battery Voltage per cell

S0C bl BxBCo6 |12 586 % State of Charge is the percent of battery capacity remaining.

i e naalla A Approximate charge/discharge rate of the battery (1C == 100%/Hr). Do not translate to
Ampere!

o T

MODE .HibStat BxB6[12] @

This bit is set when the IC is in low-power hibernate mode. During this mode, the sampling
period reduces to 45s. Fuel-gauging remains accurate if battery voltage changes sufficiently
slowly.

MODE.EnSleep |@x@6[13]

If the host sets this bit, the IC is permitted to sleep if 304 and SCL are held low, or the host
writes CONFIG.SLEEP to 1.

Version

axes

Identifies the revision of silicon

HIBRT

BB

HIBRT.HibrtThr |@xBA[@:7]

HIBRT.ActThr BxBA[8:15]

Reading...

Hibernate Threshold. Set HibrtThr and ActThr to 0x00 to disable hibernate, or both to OxFF to
hibernate always

Active Mode Threshold. Set ActThr and HibrtThr to Ox00 to disable hibernate, or both to OxFF
to hibernate always v

[# Periodically Read Regsters

Figure 18. Main Window
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MAX20353 Evaluation System

Loaded Custom Model

This group displays any custom model that has been
loaded onto the part by the software. If the device resets,
this model is automatically reloaded. If you are using the
default model, nothing is displayed here. Any changes to
the configuration file are not reloaded automatically.

Start Data Log

This group displays the file path to which the software is
recording the registers. If this box is blank, no file is being
saved.

RCOMP Configuration

You can enter a byte here and press the Write RCOMP
button to write it to the device. This is not the same as
writing the value into the register map, because RCOMP
is part of a larger 2-byte register.

If you have a custom model, you can also change the
temperature, which adjusts the fuel gauge for proper tem-
perature performance. Changing this value immediately
calculates a new value of RCOMP and displays it in the
box. This value is not written to the device until you press
the Write RCOMP button. A change to RCOMP is not
reflected in the temperature.

Registers Tab

Notation used for name and address should be familiar
to C programmers with one small change. The register
map lists:

e Register Name: A dot indicates that a single address
has multiple meanings. This is similar to how the C
firmware might access the bits.

e Command/Address: A colon indicates the 0-indexed
location, not the size of the bit field. A colon indicates
a range of values (e.g., 0x0C[0:4] is a 5-bit value,
offset 0 bits at address 0x0C).

e Value: The raw hex value as read directly from the
device.

Ordering Information

PART TYPE

MAX20353EVSYS# EVKIT

#Denotes RoHS compliant.

www.analog.com

Evaluates: MAX20353

e Meaning: A conversion of the raw hex value, usually
with units. Alert bit flags are blank when inactive, or
show text when they are alerting.

e Description: Reminders of the functionality. For
full details, refer to the MAX17048/MAX17049 IC
data sheet. The user can write values to the device
directly through the register map. To write a raw hex
value, select the cell in the Value column, overwrite
the value, and press the Enter or Tab key. You will
be prompted to write to the device. Normal commu-
nication will pause, and you will see a corresponding
blank spot in the graph.

For registers with a conversion factor (e.g., Hibernate
Threshold or VAlertMax, you can also modify the Meaning
column. The software converts the value back to the raw
hex value, and prompts to verify that you are writing what
you expect. Remember that not all registers are writable.

I2C Communication Log Tab

Here you can see a log of traffic that you initiate, as well
as any time the device is programmed. It describes each
step in detail, including the particular values read or
written. This can help remove uncertainty about how to
communicate with the device. This log does not show the
standard reading events.

Chart Tab

The chart is interactive: You can zoom into the time axis
by left-clicking and dragging anywhere in the plot area.
You will see the region highlighted as you drag. You can
zoom out either by clicking the small button in the bottom
left, or by right-clicking in the plot area. Plotted information
not in a log file cannot be recovered once the application
closes. The top and bottom plots are synchronized in
time, so zooming one zooms the other. The y axes are
fixed scale, and you cannot modify which registers are
plotted, or where.
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MAX20353 EV System Bill of Materials

Evaluates: MAX20353

ITEM REF_DES ary MFG PART # MANUFACTURER VALUE DESCRIPTION
TEST POINT; PIN DIA=0.1IN; TOTAL LENGTH=0.3IN; BOARD HOLE=0.04IN;
! BATSIM, TP1-TP14 155003 KEYSTONE NA ORANGE; PHOSPHOR BRONZE WIRE SILVER PLATE FINISH;
,  |PEULS BKIOU S, BRIOUTS e KEYSTONE A TEST POINT; PIN DIA=0.1IN; TOTAL LENGTH=0.3IN; BOARD HOLE=0.04IN; WHITE;
-5 SPOUT.S, DRNF. PHOSPHOR BRONZE WIRE SILVER;
3 C1, C2, C5, €10, C11 5 |C1005X5R1V225M050BC  |TDK 2.20F CAP; SMT (0402); 2.2UF; 20%; 35V; X5R; CERAMIC
4 C3, C4, C6, C8, C15 5 |C1005X5R0J475K050BC | TDK 4.7UF CAP; SMT (0402); 4.7UF; 10%; 6.3V; X5R; CERAMIC
5 c7 1 |C0402C273KARAC KEMET 0.027UF CAP; SMT (0402); 0.027UF; 10%; 16V; X7R; CERAMIC
6 C9, C13, C14, C16, C18, C19 6 |GRM188R60J226MET5 MURATA 22UF CAP; SMT (0603); 22UF; 20%; 6.3; X5R; CERAMIC
C1608X5R1E106MO8OAC;
CL10AT06MABNRNC; TDK:SAMSUNG
7 12, C20 2 |GRM18BR61E106MAT3;  |ELECTRONICS;MURATAMURATA |10UF CAP; SMT (0603); 10UF; 20%; 25V; X5R; CERAMIC
ZRBIBARGTEI06MEOT,  |:MURATA
GRT188R61E106ME13
GRM155R71A104KAOT;
8 c17 1 [C1005X7R1A104K050BB;  |MURATA;TDK:KEMET 0.1UF GAP; SMT (0402); 0.1UF; 10%; 10V; X7R; CERAMIC
C0402C104KBRAC
C1005X7R1C104K050BC;
ATC530L104KT16;
0402YC104KAT2A; TDK;AMERICAN TECHNICAL
CO402X7R160-104KNE;  |CERAMICS;AVK:VENKEL
CLOSB104KOSNNNC; LTD.;SAMSUNG ! .
9 c21-C26 6 |GRuTSeRITOIOMAsE:  |ELECTRONICS MURATATDK YAG| TP CAP; SMT (0402); 0.1UF; 10%; 16V; X7R; CERAMIC
C1005X7R1C104K; EO PHICOMP;TAIYO
CCO402KRX7R7BB104;  |YUDEN;SAMSUNG ELECTRONICS
EMK105B7104KV;
CLO5B104KO5
GRM31CR71H4TSKAT2;
GRJIICRTIHATSKEN!;  |MURATAMURATAMURATATTAIY ! [
10 c27,C30 I oAk vy 4.7UF CAP; SMT (1206); 4.7UF; 10%; 50V: X7R; CERAMIC
UMK316AB7475KL
C0603C225K9PAC;
1 c28 1 |GRM188R60J225KEOT;  |KEMET:MURATATDK 2.2UF CAP; SMT (0603); 2.2UF; 10%; 6.3V; X5R; CERAMIC;
C1608X5R0J225K080AB
C0402X7R500-222KNE;
12 c29 1 |GRM155R71H222KA01,  |VENKEL LTD.MURATATDK 2200PF CAP; SMT (0402); 2200PF; 10%; 50V; X7R; CERAMIC
C1005X7R1H222K050BA
C3216X5R1CA76M160AB; ] ] e
13 c31 1SRRI CATOMI0AS:  |TDKMURATA 47UF GAP; SMT (1206); 47UF; 20%; 16V; X5R; CERAMIC
C3216X5R1H106K160AB; ] ! I
14 c32 1 otons [ToKMURATA 10UF CAP; SMT (1206); 10UF; 10%; 50V; X5R; CERAMIC
15 Cc33 1 |C1608X5R1H104K0B0AA | TDK 0.1UF CAP; SMT (0603); 0.1UF; 10%; 50V: X5R; CERAMIC
16 C34 1 |GRM188R60J105KA01 MURATA 1UF CAP; SMT (0603); 1UF; 10%; 6.3V; X5R; CERAMIC;
17 Cc35 1 |C0603C475KIPAC KEMET 4.7UF CAP; SMT (0603); 4.7UF; 10%; 6.3V; X5R; CERAMIC;
18 C36 1 |C0603C104KBRAC KEMET 0.1UF CAP; SMT (0603); 0.1UF; 10%; 10V; X7R; CERAMIC
19 DS1-DS3, DS10 4 |LG L29K-G20124 OSRAM LG L29K-G2J1-24 DIODE; LED; SMT (0603); Vf=1.7V; If(test)=0.002A; -40 DEGC TO +100 DEGC
20 DS4, DS8, DS9 3 |LTST-CITATBKT LITE-ON ELECTRONICS INC. __|LTST-C171TBKT DIODE; LED; SMD LED; BLUE; SMT (0805); PIV=5V; [F=0.020A
21 DS5-DS7 3 [LTST-C150KRKT LITE-ON ELECTRONICS INC.  |LTST-C150KRKT B:E%[? LED: STANDARD: RED: SMT (1206); PIV=2V; IF=0.02A; -30 DEGC TO +85
CONNECTOR; MALE; SMT; MICRO UNIVERSAL SERIES BUS B-TYPE CONNECTOR;
2 5, 921 2 |zx620-B-5P8 HIROSE ELECTRIC CO LTD. ZX62D-B-5P8 EONMII o
23 12,53 2 |800-10-002-10-001000 MILLMAX 800-10-002-10-001000 | CONNECTOR; MALE; TH; SINGLE ROW; STRAIGHT; 2PINS
24 |J4I10-012,014, 015,020,022, 241 45 Ippcoasaan SULLINS ELECTRONICS CORP. |PBCO2SAAN CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 2PINS
CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 3PINS; -65
2 J5, J16-019, J23, 426, J39 8 |PBCO3SAAN SULLINS PBCO3SAAN NN
EVKIT PART-CONNECTOR; MALE; THROUGH HOLE; TSW SERIES; SINGLE ROW;
% 16-49 4 |Tsw-10407-Ls SAMTEC TSW-104-07-L-S RA G o
CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; RIGHT ANGLE; 12PINS;
27 93 1 |PBCOGDBAN SULLINS ELECTRONICS CORP. | PBCOSDBAN G T e
28 0, L4 2 |DFE201610E4RTM=P2 _ |MURATA 4.70H INDUCTOR; SMT (2016); METAL ALLOY CHIP; 4.7UH; TOL=+/-20%; 1.3A
29 2,13 2 |DFE201612E-2R2M MURATA 2.20H INDUCTOR; SMT (0806); WIREWOUND CHIP; 2.2UH; TOL=+/-20%; 1.8A
SWITCH; SPST; THROUGH HOLE; 24; 0.05A; TACTILE SWITCH; RCOIL=0 OHM;
30 PB1 1 |1825910-6 TE CONNECTIVITY 18259106 RINSULATION= 1000 DL TE COrECTIVIY
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MAX20353 EV System Bill of Materials (continued)

Evaluates: MAX20353

ITEM REF_DES ary MFG PART # MANUFACTURER VALUE DESCRIPTION
CRCW040210KOFK; . ) 10K 1% )
31 | R1,R2,R19,R20,R23, Ra4,Rag | 7 |2 sl b VISHAY DALE;YAGEO PHICOMP | 10K RES; SMT (0402); 10K; 1%; +/-100PPM/DEGC; 0.0630W
ERJ-2RKF3902X; . ) 30K 194 '
32 R3 T | GROWO40239KOFK PANASONIC;VISHAY DALE 39K RES; SMT (0402); 39K; 1%; +/-100PPM/DEGC; 0.0630W
R4, R6, R7, R9, R10, R12, R13, ) e )

33 Ri5, RA0.R43, RA7. REO.RES 19 |ERJ-2GEJ104 PANASONIC 100K RES; SMT (0402); 100K; 5%; +/-200PPM/DEGC; 0.1000W

34 R5, R8, R11, R14 4 |ERJ-2RKF1001 PANASONIC 1K RES; SMT (0402); 1K; 1%; +/-100PPM/DEGC; 0.1000W

35 R16-R18, R21 4 [CRCW0402499RFK VISHAY DALE 499 RES; SMT (0402); 499; 1%; +/-100PPM/DEGC; 0.0630W

36 R22, R36, R37 3 |CRCWO040210R0JNEDHP  |VISHAY DRALORIC 10 RES; SMT (0402); 10; 5%; +/-200PPM/DEGK; 0.2000W

37 R25-R30 6 |ERJ-2RKF3000 PANASONIC 300 RES; SMT (0402); 300; 1%; +/-100PPM/DEGC; 0.1000W
RESISTOR; THROUGH-HOLE-RADIAL LEAD; PV36 SERIES; 1M OHM; 10%; 100PPM;

38 R31, R32 2 [Pvaey10scotBo0 MURATA ™ 0.5W; TRIMMER POTENTIOMETER; 25 TURNS; MOLDER CERAMIC OVER METAL
FILM

39 R33 1 |CRCW04023K40FK VISHAY DALE 3.4K RES; SMT (0402); 3.4K; 1%; +/-100PPM/DEGC; 0.0630W

40 R45, R46 2 [wsLososR1000FEATS VISHAY DALE 0.1 RES; SMT (0805); 0.1; 1%; +/-75PPM/DEGC; 0.1250W
RESISTOR; THROUGH-HOLE-RADIAL LEAD; 3296 SERIES; 25K OHM; 10%;

4 R48 1 |3296Y-1-253LF BOURNS 25K 100PPM; 0.5W; SQUARE TRIMMING POTENTIOMETER; 25 TURNS; MOLDER
CERAMIC OVER METAL FILM

42 R51 1 |ERJ-2GEOR00 PANASONIC 0 RES; SMT (0402); 0; JUMPER; JUMPER; 0.1000W

43 R52 1 |ERJ-2RKF5100 PANASONIC 510 RES; SMT (0402); 510; 1%; +/-100PPM/DEGC; 0.1000W.

44 R59 1 |ERJ-2RKF1152 PANASONIC 11.5K RES; SMT (0402); 11.5K; 1%; +/~100PPM/DEGC; 0.1000W

s SPACER1.SPACERS s |s0s2 KEYSTONE 9032 MCESILNE FABRICATED; ROUND-THRU HOLE SPACER; NO THREAD; M3.5; 5/8IN;
TEST POINT; PIN DIA=0.1IN; TOTAL LENGTH=0.3IN; BOARD HOLE=0.04IN; RED;

46 TPIS-TP1S 5 |5000 KEYSTONE NA PHOSPHOR BRONZE WIRE SILVER PLATE FINISH;
TEST POINT; PIN DIA=0.1IN; TOTAL LENGTH=0.3IN; BOARD HOLE=0.04IN; BLACK;

4 TP20-TP31 12 5001 KEYSTONE NA PHOSPHOR BRONZE WIRE SILVER PLATE FINISH;
EVKIT PART- IC; WEARABLE POWER NAMAGEMENT SOLUTION; PACKAGE

48 ut 1 |MAX20353 MAXIM MAX20353 OUTLINE; WLP 56 PINS; 0.5MM PITCH; PKG. CODE: W563A4+1; PKG. OUTLINE: 21-
100104

49 ) 1 |OPAS69AIDWPR TEXAS INSTRUMENTS OPA569AIDWPR IC; AMP; RAIL-TO-RAIL I/0; POWER AMPLIFIER; WSOIC20-EP 300MIL

50 U 1 |vaxsssoeuts MAXIM MAXBB80EUT+ g:o ;/gtfg;; ULTRA-LOW-IQ LOW-DROPOUT LINEAR REGULATOR WITH POK;

51 U4 1 [NcTwzo7Pex FAIRCHILD SEMICONDUCTOR | NC7WZ07P6X IC; BUF; TINY LOGIC ULTRA-HIGH SPEED DUAL BUFFER; SC70-6

52 PCB 1 |MAX203535YS MAXIM PCB PCB:MAX203535YS

53 MISC1, MISC2 2 |3025010-03 QUALTEK ELECTRONICS CORP  {3025010-03 gg”:NECTOR; MALE; USB-A_MINI-B; USB 4P(A)/M - USB MINI SP(B)M; STRAIGHT;

54 MISC3 1 |MAXPICO2PMB# MAXIM MAXPICO2PMB# ACCESSORY; BRD; PACKOUT; PICO2PMB ADAPTER BOARD

TOTAL 182
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MAX20353 EV System Schematic (continued)

Evaluates: MAX20353
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MAX20353 EV System Schematic (continued)
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MAX20353 EV System PCB Layout

Evaluates: MAX20353
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MAX20353 EV System PCB Layout (continued)
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Revision History

REVISION | REVISION PAGES
NUMBER DATE DESCRIPTION CHANGED
0 3/21 Initial release —
4/21 Updated the Bill of Materials, Schematic, and PCB Layout Diagram sections 21-28
Updated General Description, EV System Contents, Quick Start, and Detailed
2 8/21 Description of Software sections, Figures 1, 2, and 4-15, and Bill of Materials; 1-16, 18, 20, 23
Added Fuel Gauge section
3 1/22 Updated Hardware Setup section and Table 2 18, 20
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